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About this Guide

This guide provides all the information that you need to prepare for the
Aperture 3 exam to earn Apple Certified Pro Level One certification. From
this guide you can:

 Learn about Apple Certification.
« Find out how to take the exam.
* Locate resources to help you prepare for the exam.

» Review the range of objectives that the exam may cover.

Becoming an Apple Certified Pro

The Apple Training & Certification program is designed to keep you at the
forefront of Apple technology. Certification creates a benchmark to
demonstrate your proficiency in specific Apple technologies and gives you
a competitive edge in today’s evolving job market.

What is an Apple Certified Pro?

An Apple Certified Pro is a user who has reached the highest skill level in
the use and operation of Apple’s Pro Applications as attested to by Apple.

How do | become an Apple Certified Pro?

To become an Apple Certified Pro, you must pass an online exam
administered at an Apple Authorized Training Center (AATC). Some exams,
including Aperture, may be taken online by individuals with a promotional
code. Level One exams are administered at the end of specific courses at
the centers. If you prefer to learn on your own or believe you already have
the necessary skills, you may take the Aperture exam online for a fee.

Level One certification attests to basic operational knowledge. Level Two
certification attests to a deeper understanding of the application. Level
Two exams can be taken only after Level One certification is earned. Class
attendance is recommended, but not required. Currently, Aperture only
offers Level One certification.

What are the benefits of being an Apple Certified Pro?

Beside differentiating you as a skilled user of an Apple application,
becoming an Apple Certified Pro allows you to leverage the power of the
Apple brand. When you pass a Certification exam, you receive an email
with a PDF copy of your Apple certificate, along with instructions on how
to order a printed or a printed and framed certificate. The email includes
LinkedIn, Facebook, and Twitter icons to make it easy for you to share your
certification news with your networks on these sites.

You also receive a login for the Apple Certification Records System, where
you can:

 Update your profile information and opt in to display your Apple
Certification(s) on the Apple Certified Professionals Registry.
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Review your certification progress.

Download your certification logo(s) to use on business cards, resumes,
websites, and more.

Provide access to employers to verify your certifications.

Exam Details

The Aperture 3 Level One exam is a computer-based test offered at AATCs
and online to eligible individuals who have a promotional code. A
promotional code appears later in this guide. To find the closest AATC,
please visit training.apple.com/locations.

Many AATCs schedule Certification Exam sessions at training.apple.com/
schedule. If you don't see a session scheduled at your nearest AATC,
contact the AATC and they will often schedule a session. Please note
that all AATCs offer all Mac OS X and Pro Apps exams, even if they
don't offer the corresponding course.

The Aperture 3 Level One exam details:
Exam number: 9L0-847

Number of test questions: approximately 54 technical, five
demographic (unscored)

The exam uses a random pool of multiple-choice, fill-in-the-blank and
interactive-media questions.

Passing score: 80% (scores are not rounded; you must earn a score of
80% or higher to pass the exam)

Details on exam scoring appear at training.apple.com/certification/faq
Exam duration: One hour thirty minutes

This exam is also available in other languages. For details, please visit
training.apple.com/certification/localized.

The exam timer does not start until you view the first technical question.
You may not access any resources or references during the exam.

Recommended Exam Preparation

We recommend the following exam preparation strategies:

Gain experience with the application.

Learn from experts: Introduction to Aperture 3 course.

Study the Apple Pro Training Series book “Aperture 3" by Dion
Scoppettuolo (ISBN 0-321-63527-2).

Review the optional study materials.

Review the objectives and sample questions in this guide.
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Gain Experience with the Application

Nothing can substitute for time spent learning the application first hand.
After you read the book and/or take the class, spend time increasing your
familiarity with the software on your own to ensure your success on the
certification exam.

Learn from Experts

Apple Authorized Training Centers (AATCs) offer classes where you can
learn hands-on with the technology and benefit from the expertise of
Apple Certified Trainers and your peers. Visit the Apple Training &
Certification website to find course offerings at nearby AATCs.

Study the Apple Pro Training Series Book

Apple Pro Training Series books are the basis for the related Apple
Certification exams. The book for this exam is Apple Pro Training Series
“Aperture 3" by Dion Scoppettuolo (ISBN 0-321-63527-2). You can purchase
the book at peachpit.com (click here for a 30% discount code). Creative
Edge, an on-demand digital library, offers subscription access to the Apple
Training and Apple Pro Training Series, as well as thousands of other
reference videos and books. If you are an iPad user, an electronic version is
also available on the iBookstore. This book is also available in other
languages. Click here for details.

Review the Optional Study Materials

The following resources may also help you to prepare for your certification
exam, as well as to expand your general knowledge:

 Review the appropriate sections of the documentation, which is
available at: documentation.apple.com. You can also launch the
Aperture documentation by choosing Help > Aperture Manual or Help
> New Features when Aperture is launched.

» Review the Apple Pro Video Series “Aperture 3” by Damian Allen. This
DVD features over three hours of video tutorials and a printed quick-
reference guide.

« If you are new to the Macintosh, you may want to review the tutorials
at: www.apple.com/support/maci101/ and www.apple.com/
findouthow/mac/.

» Many online resources allow you to ask questions and learn tips and
tricks. Access white papers, discussion forums, and other online
materials on the Aperture resources page: www.apple.com/Aperture/
resources/. You can also download a free trial from this link.

» Watch the tutorials at www.apple.com/aperture/how-to/.

« Take the guided tours at www.apple.com/aperture/whats-new.html.

» Read the late breaking news at www.apple.com/support/manuals/.
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Review the Objectives and Review Questions

Even if you're self-taught or have taken courses that do not use the Apple
Pro Training Series curriculum, you can still prepare yourself for the
certification exam by making sure that you can complete all the tasks and
answer all the review questions in the following sections.

The Exam Objectives describe the knowledge domains assessed by the
exam. The Review Questions summarize what you should have learned in
each chapter. Please note that although this guide divides the objectives
into lessons or knowledge areas, questions are presented randomly during
the exam.

The number of test questions drawn from each knowledge area is
indicated for each of the following lessons. Please note that although this
guide divides the objectives into 13 lessons or knowledge areas, questions

are presented randomly during the exam. The Apple Pro Training Series
“Aperture 3“ book includes 13 lessons plus two Appendices. However, only
Lessons 1 through 13 are included on the end user exam.

Lesson One objectives

Upon completion of Lesson One,“A Quick Tour of Aperture”in the Apple
Pro Training Series book “Aperture 3,” you should be able to complete the
following tasks. Approximately 12 items from this lesson are included in the
pool of exam questions, drawn randomly from the following objectives:

Import images from a memory card
Navigate the Browser

Delete images

Straighten, rotate, and crop images
Apply ratings to images

Send images via email

Lesson One review questions

After completing Lesson One, you should be able to answer the following
questions:

1. What is the function of the Aperture library?

2. Identify the three main window layouts, along with the
keyboard shortcut used to cycle through these layouts.

3. How can you completely remove an image from the Aperture
library and the Mac’s hard drive?

4. How do you enable and disable a flag attached to an image?

5. What happens when you choose ***** from the pop-up
menu in the Aperture Search field?

6. Where will you find the Aperture adjustment controls?
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Answers

1. The Aperture library is a container where your images are
stored and every project, album, image, and adjustment is
tracked. The Library inspector displays your organizational
hierarchy. It can contain projects, albums, folders, books, web
galleries, and web journals.

2. The Browser, Viewer, and Split View are the three main
window layouts. The V key can be used to cycle through the
three views.

3. To completely remove an image from the Aperture library
and Mac hard drive, you must press Command-Delete in
Aperture and then choose Empty Trash from the Aperture
menu. You must then empty the Mac’s Trash.

4. To enable or disable a flag attached to an image, click in the
upper-right corner of the image’s thumbnail.

5. Aperture sifts the Browser to show you only the images in
your library that you've given five-star ratings.

6. The adjustment controls are found in the Adjustment
inspector and the Adjustments pane of the Inspector HUD.

Lesson Two objectives

Upon completion of Lesson Two, “Adding and Managing Metadata” in the
Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately four items from this lesson are
included in the pool of exam questions, drawn randomly from the
following objectives:

Import images from the Finder

Rename both versions and master file names
Adjust time zone during importing

Add IPTC metadata

Define and organize keywords

Perform batch changes on metadata

Modify metadata views

Auto-fill metadata fields using metadata presets

Create albums and Smart Albums

Lesson Two review questions

After completing Lesson Two, you should be able to answer the following
questions:

1. How does time adjustment work?
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2. How can keywording help you?

3. How do you let Aperture know that you do not want to
import specific images in the Import browser?

4. How would you show only those images in the Browser that
were taken on a specific day, month, and year?

5. What is the difference between albums and Smart Albums?

Answers

1. Time adjustment uses the camera time zone as a starting
point and creates an adjusted time zone based on where a
photo was shot.

2. Keywording can be used in addition to the information that'’s
embedded in an image to differentiate between images. This
will allow you to create useful searches that can quickly find
images inside a project or an entire library.

3. Inthe Image browser, checkboxes are selected to identify
images that will be imported. You can deselect a checkbox on
images that you do not want Aperture to import.

4. Use the Filter HUD in the Browser to filter images based on
any IPTC Core or EXIF metadata, including when the image
was taken.

5. Albums are static groupings of images into which you

manually add images. Smart Albums are dynamically updated
with images based on filter criteria.

Lesson Three objectives

Upon completion of Lesson Three, “Comparing and Evaluating Images”in
the Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately seven items from this lesson
are included in the pool of exam questions, drawn randomly from the
following objectives:

Evaluate images in Full Screen view
Examine detail using the Loupe
Compare and rate images

Organize a series of images into stacks

Arrange photo collections on the Light Table

Lesson Three review questions

After completing Lesson Three, you should be able to answer the following
questions:

1.

How does Quick Preview work?
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What is stacking?
What information does auto-stacking use?
What is the pick of a stack?

True or false: Rejecting an image adds it to the Aperture Trash.

Answers

1.

Quick Preview uses smaller image previews rather than
decoding the original image files. If the generated preview
isn't available, Aperture will use the embedded JPEG, if
available.

Stacking is a way to organize a series of similar images. You
can auto-stack images or stack them manually. Stacking
groups your images for viewing purposes; it doesn’t change
where they're stored within your Aperture library.

Auto-stacking uses the timestamp metadata.
The first image in a stack is the pick of the stack.

False. Rejecting an image is just part of the rating system and
does not move images into the Trash.

Lesson Four objectives

Upon completion of Lesson Four,“Indexing Photos Using Faces and Places”
in the Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately five items from this lesson are

included in the pool of exam questions, drawn randomly from the
following objectives:

Import photos from the iPhoto Browser
View a photo’s location on a map
Assign a location to a photo and project
Import a GPS track log

Name detected faces in a project
Assign missing faces

Create Smart Albums of specific people

Lesson Four review questions

After completing Lesson Four, you should be able to answer the following

questions:

1. How do you import a single photo from your iPhoto library
into Aperture?

2. Whatis GPX?

3. How do you view a map only for photos of a certain project?



Aperture 3 Exam Preparation Guide

4. Where do you find the menu to create a new Smart Album
based on the Places view?

5. How do you add a name to a face that has not been located
by Aperture?
Answers

1. Choose File > Import > iPhoto Browser. The iPhoto Browser
appears and allows you to view and select individual photos
in iPhoto. Choosing Import > iPhoto Library imports the
entire iPhoto library.

2. GPXis one of the GPS track log file types that Aperture can
import. The other sup- ported format is NMEA.

3. Select the project, and then click the Places button in the
toolbar. Selecting the Places view in the Library inspector will
show you the locations for all projects.

4. The“New Smart Album from View” is found in the Places
Action pop-up menu in the tool strip.

5. Select an image to display in the Viewer. In the toolbar, click
the Name button, and in the dialog click the Add Missing
Face button. Finally, type a name in the label.

Lesson Five objectives

Upon completion of Lesson Five,“Managing Projects and the Library”in the
Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately three items from this lesson
are included in the pool of exam questions, drawn randomly from the
following objectives:

Import referenced files

Create a backup during import

Manage images and referenced files

Create folders and move images between projects
Work with multiple libraries

Move projects between portable and desktop Macs

Back up and restore images using vaults

Lesson Five review questions

After completing Lesson Five, you should be able to answer the following
questions:

1. Describe the difference between a managed library and a
referenced library.
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2.  Which backup method backs up your master images and all
the projects, metadata, and adjustments you've applied in the
Aperture library and which backs up only your master
images?

3. How do you select a new location for your Aperture library?

4. What is the difference between using the Consolidate Masters
and Relocate Masters options?

5. What happens to referenced files when you back up using a
vault?

Answers

1. A managed library stores all your master images in the
Aperture library. A referenced library can store master files
anywhere.

2. The vault backs up your entire Aperture library and all its
items. A backup created in the import settings backs up only
master images.

3. Choose Aperture > Preferences and indicate where you
moved the library file or where you would like to store the
new library.

4. Consolidate Masters is used to move referenced files into the
Aperture library. Relocate Masters is used to move referenced
files to a new location on your hard disk. If you use Relocate
Masters on a file that is stored within the Aperture library,
that file becomes a referenced file.

5. Nothing. Referenced files are not included in vaults. Only
managed files, projects, and other library items, metadata,
and adjustments are included in the vault.

Lesson Six objectives

Upon completion of Lesson Six, “Performing Nondestructive Editing” in the
Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately six items from this lesson are
included in the pool of exam questions, drawn randomly from the
following objectives:

Add and remove adjustments
Read a histogram display
Correct overexposed images
View hot and cold areas
Adjust contrast and definition
Create new versions

Apply adjustments using Lift and Stamp tool
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Lesson Six review questions

After completing Lesson Six, you should be able to answer the following
questions:

1. How do you reset the entire Adjustments inspector after
applying a preset?

2. Ifagraphis cut off at the right edge of the histogram, what
does this indicate?

3. Where would you adjust the exact pixel width and height for
the Crop tool?

4. True or false: Adjusting the black point will also adjust your
highlights.

5. True or false: Exposure controls can be used to recover
highlights in an image
Answers

1. From the Adjustment Action pop-up menu, choose Reset All
Adjustments.

2. Highlights are being clipped and causing a loss of detail.

3. The Adjustments inspector provides numeric control over the
precise width and height of the Crop tool.

4. False, the Black Point slider adjusts only your shadows, leaving
your highlights unaltered.

5. True. Although you would more commonly use the Recover
parameter controls, the Exposure parameter controls also
lower your white point, thereby recovering clipped highlights.

Lesson Seven objectives

Upon completion of Lesson Seven,“Correcting Tone” in the Apple Pro

Training Series book “Aperture 3,” you should be able to complete the
following tasks. Approximately two items from this lesson is included in the

pool of exam questions, drawn randomly from the following objectives:
Adjust images in Full Screen view
Apply contrast and definition
Recover highlights and shadows
Adjust levels with the Quarter-Tone Levels controls
Convert color images to black and white

Examine versions using the compare feature
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Lesson Seven review questions

After completing Lesson Seven, you should be able to answer the
following questions:

1. Name two of the three ways you can select another project
while in Full Screen view.

2. How does adjusting the Highlights & Shadows controls affect
an image?

3. How do you adjust just the highlights or shadows without
impacting the midtones, black point, or white point in the
Levels adjustment?

4. True or false: Black-and-white filters from the Presets menu
cannot be changed after they are applied.

5. Are stacks required to use the compare feature?

Answers

1. The three ways to select projects in Full Screen view are using
the Library Path Navigator pop-up menu at the top of the
Browser, from the Library tab in the Inspector HUD, or
selecting Projects in the top left of the Browser to see the
Projects view.

2. If you drag the Highlights slider to the right, the bright areas
of your image will get darker. If you drag the Shadows slider
to the right, the dark areas of your image will get brighter.

3. Enabling the Quarter-Tone controls in the Levels adjustment
will display sliders for highlights and shadows.

4. False.The filters can be adjusted using the Black & White
adjustment brick that is applied when you select a Black &
White filter preset.

5. No, stacks are not required. The compare feature uses a
selected compare image, out- lined in green. The image
immediately to the right in the filmstrip view is then chosen
as the first image you want to examine next to the compare
image.

Lesson Eight objectives

Upon completion of Lesson Eight, “Correcting Color” in the Apple Pro

Training Series book “Aperture 3,” you should be able to complete the
following tasks. Approximately two items from this lesson are included in

the pool of exam questions, drawn randomly from the following objectives:
Enhance an image using the Saturation and Vibrancy controls
Adjust individual colors in an image using the Color controls

Use curves to correct luminance and color
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Correct chromatic aberration

Specify and use an external editor

Lesson Eight review questions

After completing Lesson Eight, you should be able to answer the following
questions:

1. When editing with an external editor, what file does Aperture
send to the external application?

2. What does the Add Point button do in the Curves
adjustment?

3. What's the functional difference between the White Balance
and Tint controls?

4. Can curves be used to correct white balance issues?

5. True or false: It's impossible to adjust the hue, saturation, and
luminance of a color that does not appear in the Color
controls.

Answers

1. Aperture creates a new master file, which is sent to the
external application. You can choose to create a PSD or TIFF
format file in 8- or 16-bit resolution.

2. The Add Point button can be used to select a point on the
image, which is then mapped to the curve editor to place a
curve point.

3. The White Balance control makes uniform adjustments to all
tonal values in an image. The Tint Controls can selectively
neutralize color casts that affect only the shadows, midtones,
or highlights.

4. Curves can adjust both luminance and color. Because it can
adjust individual RGB color channels, you could use it to
correct white balance issues.

5. False. You can use the Color eyedropper to identify any image
hue that needs adjusting.

Lesson Nine objectives

Upon completion of Lesson Nine, “Making Local Adjustments with

Brushes” in the Apple Pro Training Series book “Aperture 3,” you should be
able to complete the following tasks. Approximately two items from this

lesson are included in the pool of exam questions, drawn randomly from
the following objectives:

Use Quick Brushes to correct problematic areas.

Add blur to simulate shallow depth of field.
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Smooth skin imperfections.

Darken shadows and midtones with the Polarize brush.
Repair images with the Retouch tool.

Remove purple fringing artifacts.

Create a brush from an adjustment.

Use multiple instances of an adjustment.

Lesson Nine review questions

After completing Lesson Nine, you should be able to answer the following
questions:

1.
2.

Name two of the three places you can access Quick Brushes.

What is the major difference between the Repair brush and
the Clone brush?

What two brushes does Aperture offer for cleaning up brush
strokes?

If you wanted to darken your image but retain the highlights,
is Polarize or Burn the better Quick Brush to use? Explain your
answer.

True or false: Only brushes created from the Adjustments
inspector are nondestructive. Quick Brushes create new 16-bit
TIFF or PSD format master files.

Answers

1.

You can access Quick Brushes in the Adjustments Inspector’s
Adjustments pop-up menu, from the Quick Brush pop-up
menu in the tool strip, and from the toolbar in Full Screen
view.

The Repair brush copies pixels from one area (the source) and
paints it over the destination area. The Repair Brush then
performs an additional step, attempting to blend the tones
and colors of the copied area to match the destination area,
while preserving the original source texture. The Clone brush
is a straight copy/paste from one area of an image onto
another area. Unlike the Repair brush, the Clone brush does
not blend pixels in the area surrounding the brush stroke.

Aperture has two tools for cleaning up brush strokes: The
Eraser tool is used to remove stray or errant strokes; the
Feather tool is used to create gentler blends along the edges
of a stroke.

Polarize would be the better Quick Brush to use. The Polarize
brush darkens the shadows and midtones, making the color
in those areas much richer. It leaves highlights unaltered. Burn
darkens the highlights, midtones, and shadows of an image.
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5. False. All adjustments and brushes in Aperture are
nondestructive. Master files are created only when you use an
external editor.

Lesson Ten objectives

Upon completion of Lesson Ten, “Working with RAW Images” in the Apple
Pro Training Series book “Aperture 3,” you should be able to complete the
following tasks. Approximately two items from this lesson are included in
the pool of exam questions, drawn randomly from the following objectives:

Update RAW decoding method
Refine the RAW decoding process using the Fine Tuning controls

Work with DNG files

Lesson Ten review questions

After completing Lesson Ten, you should be able to answer the following
questions:

1. What is the benefit of working with a RAW file compared to a
JPEG file?

2. If you were using a JPEG file, where would you access the
Edge Sharpening controls?

3. True or false? RAW files are the same size as JPEG files, but
RAW files provide more detail in the highlights and shadows.

4. If you find that all RAW images from the same camera need
the same adjustments, how can you apply the adjustments
you made to a single image to all RAW images from that
camera?

Answers

1. RAW files retain more detail and dynamic range and offer
more flexibility for image editing than JPEG files.

2. Edge Sharpening for JPEG files can be applied only by using
the Edge Sharpening adjustment from the Adjustments
menu.

3. False, RAW files do provide more detail in the highlights and
shadows, but they are much larger than JPEG files.

4. When you complete your adjustments, choose Save As
Camera Default.

Lesson Eleven objectives

Upon completion of Lesson Eleven, “Creating Dynamic Slideshows” in the
Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately seven items from this lesson
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are included in the pool of exam questions, drawn randomly from the
following objectives:

Navigate slideshow presets

Customize slideshow albums

Add titles, transitions, and photo effects
Mix main and secondary audio tracks
Edit a slideshow to a musical beat

Share to MobileMe and YouTube

Lesson Eleven review questions

After completing Lesson Eleven, you should be able to answer the
following questions:

1. Why would you choose to use a slideshow preset over a
slideshow album?

2. What two themes could you choose if you wanted to
customize the transitions between slides?

3. What is the difference between changing the Transition type
in the Default Settings pane and changing the Transition type
in the Selected Slides pane?

4. What happens when you drag an audio file directly onto a
slide?

5. True or false: Slideshows that are exported to YouTube from
Aperture are uploaded directly to the website.

Answers

1. Slideshow presets are a perfect solution to quickly create a
slideshow that you don't need to save or export for later use,
or when you want to manually change slides; for instance,
when using slides as talking points during a presentation.

2. The Classic theme and the Ken Burns theme have the most
options. They are the only two themes that allow you to
modify transitions.

3. The Default Settings are global settings that affect every slide
in the slideshow. Selected Slides settings affect only the slides
that are selected in the Browser.

4. Dragging an audio file to a slide in the Browser adds a
secondary audio track. Dragging an audio file to the gray area
of the Browser adds it as the main audio track.

5. False. Slideshow movies exported from Aperture are placed in
the Aperture Slideshows folder, in the Pictures folder. The files
are not uploaded automatically. You must upload the movie
files using QuickTime or directly to the YouTube website.
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Lesson Twelve objectives

Upon completion of Lesson Twelve, “Presenting Your Photos on the Web”in
the Apple Pro Training Series book “Aperture 3,” you should be able to
complete the following tasks. Approximately one item from this lesson is
included in the pool of exam questions, drawn randomly from the
following objectives:

Create a MobileMe album

Access a MobileMe album from an iPhone or iPod touch
Post photos to Facebook and Flickr

Build and customize a web journal to showcase photos

Publish a web journal

Lesson Twelve review questions

After completing Lesson Twelve, you should be able to answer the
following questions:

1. Of the three photo sharing web services built into the
Aperture toolbar (MobileMe, Facebook, and Flickr), which
service allows you to control who can view your photos?

2. If you upload images from iPhoto to a MobileMe gallery
album created by Aperture, will Aperture download the
images uploaded by iPhoto?

3. How do you first assign a theme to a web journal?

4. How can you place a short descriptive sentence under each
photo?

5. What publishing options are available for web journals?

Answers
1. All three services allow you to set who can view your photos.

2. Yes, Aperture can check to see whether new images or
entirely new albums have been uploaded to your gallery from
other sources such as iPhoto, an iPhone, or a web browser. It
can then download the new images or albums to the
MobileMe section of the Library inspector.

3. Choose New > Web Journal to display the Web Journal dialog
with a few setup options, including a list of themes that you
can apply.

4. First, write a descriptive sentence for each image in the
Caption metadata field. Then in the Webpage Editor, select a
metadata view that contains the Caption field.

5. You can publish web journals to your MobileMe account or
export the pages for load- ing to a server of your choice.
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Lesson Thirteen objectives

Upon completion of Lesson Thirteen, “Delivering Final Images as Books,
Prints and Files” in the Apple Pro Training Series book “Aperture 3,” you
should be able to complete the following tasks. Approximately two items
from this lesson are included in the pool of exam questions, drawn
randomly from the following objectives:

Compose, proof, and purchase a finished book
Prepare and order printed images

Export masters and versions

Lesson Thirteen review questions

After completing Lesson Thirteen, you should be able to answer the
following questions:

1. Describe two ways autoflow works to place images on pages.
2. Can keywords be embedded into a master image?

3. How can you tell how many times an image appears in a
book?

4. True or false: An exported master contains all the edits and
adjustments you've made to an image in Aperture.

Answers

1. The Autoflow feature can very quickly place all the images, or
just the images you select, from the Browser into the empty
photo boxes of your book.

2. Yes, any IPTC metadata you've prepared in Aperture can be
written into the masters you deliver by choosing Metadata >
Include IPTC in the Export window. You can also write IPTC
metadata into the original master images by choosing
Metadata > Write IPTC Metadata to Masters.

3. In the Browser you'll see that every picture placed in a book
has a red badge in the upper right containing a number to
indicate how many times the image appears in the book.

4. False. Exported masters are virtually identical copies of the
images you originally imported into Aperture, which means
that they contain none of the changes you may have made
using the various image manipulation tools.

Appendix A and Appendix B

The Apple Pro Training Series “Aperture 3" book includes 13 lessons plus
two appendices. However, only Lessons 1 through 13 are included on the
end user exam. Please note that if you are an Apple Certified Trainer, all
Lessons are included on the trainer exam.
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Taking the Certification Exam

As a special offer, owners of the Apple Pro Training Series book “Aperture
3"are eligible to take the Aperture Level One certification exam online for
$75.00 USD. Normally you must pay $150.00 USD to take the exam in a
proctored setting. If you do not have an exam code from this book, you
can use the code in the following instructions to take the exam online.

Taking the exam

If you do not pass the exam on the first try, retake instructions are included
in the results email, so do not discard this email. Retakes are $75. You can
only take the exam once per week, so please plan accordingly.

Please note that you may not use any study materials, including the book,
or open the Aperture 3 application while taking your exam.

1. Go to ibt.prometric.com/apple on a system that meets the
minimum system requirements: Mac OS X 10.5 or higher,
Safari 3.2.2 or higher (other browsers are not fully supported)
and a Cable / DSL / broadband connection. If your system
does not meet the requirements, you are not eligible to take
the exam online and will need to take it at an Apple
Authorized Training Center (AATC). You can find the closest
AATC at training.apple.com/locations.

2. C(lick Secure Sign-In (uses SSL encryption) and log in with
your Prometric Prime ID and password. If you don't already
have an ID, click First-Time Registration and follow the
instructions to create a Prometric Prime ID and password.

3. C(lick Continue to access the Candidate Menu page.

4. C(lick Change Domain on the left and set the Domain
to IT&ProApps (skip to the next step if you do not see a
Change Domain link).

5. In the Candidate Menu page, click Take Test.

6. Enter APT3EUEP in the Private Tests box and click Submit.
The code is case sensitive and is only valid for one use.

7. Click Take This Test.
8. Read and Agree/Accept the Certification Program Agreement.

9. C(lick Continue to skip the voucher then enter your credit
card information to pay the $75 USD fee.

10. Click Begin Test at the bottom of the page.
11. When you finish all the questions, click End Test.

12. When you finish, click End Test. If you do not pass the exam,
retake instructions are included in the results email from
Prometric. You have to wait seven days before you can take
the exam again, so please plan accordingly.


http://tk.publicaster.com/DC/ctr.aspx?6C6164=31383837333639&736272=4&747970=6874&66=30
http://tk.publicaster.com/DC/ctr.aspx?6C6164=31383837333639&736272=4&747970=6874&66=30
http://training.apple.com/locations
http://training.apple.com/locations
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Prometric Exam FAQs

Please visit training.apple.com/certification/faq for a list of Frequently
Asked Questions. If you do not find the answer to your question, then
email us. Please allow at least two business days for a response.
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